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eCatalogs

Electronic product catalogs, also known as eCatalogs, are data files in STEP that contain product and price
information for a specific product selection, typically stored in a product collection.

eCatalog Elements

An eCatalog object consists of three elements:

« A collection of the products go into the eCatalog. A collection can be either dynamic or static.

« A price list, which contains the prices that are valid for the eCatalog. A price list consists of product with its
terms. A term for a product is a combination of a value and a set of conditions such as Minimum Quantity,
Maximum Quantity, Start Date, and End Date.

« AneCatalog configuration, which specifies the output format, the delivery method, and the mapping between
internal product attributes and the attributes of the export format.

-] GDSM Receiver
{E Merge_Golden_Root
@ Promotions
@ Publications
r_=| Primary Product Hierarchy
@ Collections
E|i eCatalogs
B eCat
eCatalog Configuration
e ﬁ eCat Prices
Jﬁ Recyde Bin

eCatalog Price Lists and Commercial Data Lists

Price lists used in eCatalogs are identical in format to the price lists used for commercial data in STEP Publisher.
They contain the same elements (Value, Unit, Quantity, Dates), use the same default System Setup commercial
object type of Price (Price), and are mapped identically in the Import Manager. The difference between the two is
in their intended output. eCatalog price lists are intended for electronic output, and commercial data lists are strictly
used in STEP Publisher print publications.

Since eCatalog price list import configurations are mapped using commercial data options in the Import Manager,
the term 'commercial data' is frequently used in this guide to refer to the contents of eCatalog price lists. For more
information on commercial data, see the Commercial Data section of the STEP Publisher (InDesign)
documentation.
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Creating an eCatalog

To create a new eCatalog, follow these steps.

1.
2. Right-click and select New eCatalog.

3.

Inthe Tree, select eCatalogs.

r_=| Merchandising Hierarchy

r_=| Suppliers
(- 7] UNSPSC-CODE

[ <otoios I

' Description

Mame
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T ISTIBOSYSTEMS
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-] Promotipry

-1l Publicgt Copy Ctrl+C
(+-{I] Prim & cut Ctrl+X
@ Coll Paste Ctrl+V

x

Mew Price List
Create Collection From File...

Mew eCatalog Configuration

Export eCatalog

Delete

e MASTER DATA MANAGEMENT

In the Create eCatalog dialog, enter an ID and Name for the eCatalog, then click Create.

Create eCata

||:|g

D AcmePrices

Mame |Acme Prices

Create Cancel

4. The eCatalog is created.
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The next steps are to add the following elements to your eCatalog:

» A price list that contains the prices that are valid for the eCatalog.
« A product collection that contains a list of all the products that go into the eCatalog.

« An eCatalog configuration that specifies the output format, the delivery method, and the mapping between
internal product attributes and the attributes of the export format.
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Creating a Price List

A price list consists of terms. A term for a product is a combination of a value (price) and a set of conditions such

as Minimum Quantity, Maximum Quantity, Start Date, and End Date.
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The first step when setting up your eCatalog is to create a price list that holds the prices of the eCatalog.

1.

In the Tree, select the eCatalog that you want to create a price list for.

2. Right-click, and then click New Price List.

3.
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&[] Company Hierarchy Data Root
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£ s |
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F¥l- £ Entity Root
[#-{] GDSN

Mew eCatalog

Mew Price List

[#-{[] GDSN Receiver
@ Merge_Golden
-] Promotions
ﬂ Publications
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. [ eCat
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T i Bl

b4

Create Collection From File...
Mew eCatalog Configuration
Mew List

Copy
Cut

Paste
Export eCatalog

Delete

9 Desaiption

Ctrl+C
Ctrl+X
Ctrl+V

In the Create Price List dialog, enter an ID and a Name for the price list, then click Create.
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Create Price List

D |A::meSprir1gPri::es

Marme |A::me Spring Prices

4. Onthe Price List tab, the following optional settings are available.
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=y Entity Root

{7 GDSN
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e ot [
9 E . I-

Mame

Value

D
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Mame
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Cbiject Type

Immutable

Act as selection list

Price
L]
[]

Import Configuration

Currency

]

Last modification time

Expiry date

Default Start-date

Default End-date

El | E | E | E

o Immutable: When checked, this setting prevents commercial data from being updated.

« Act as selection list: Enable this option to have the products included in the price list serve as the product
selection for the eCatalog. If a collection is added to the eCatalog, the collection serves as the product list, and
this option will be disabled. For more information on adding a collection to an eCatalog, see the Selecting

Products for eCatalogs topic.

« Import Configuration: Specifies the import configuration to be used for the price list. Click the ellipsis button (
E) to select the saved import configuration.

« Currency: Click the ellipsis button (E) to choose a currency unit for the list. This selection can be any unit and

does not have to be currency.
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. Last modification time: Displays the date and time that the list was last modified. This field is non-editable.
« Expiry date: Enter an expiration date for the list, or double-click the field to open the Date Picker.

» Default Start-date and Default End-date: Like Expiry date, these values are for administrative purposes
only and are not the same as the 'Start Date' and 'End Date' values defined for individual terms.
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Defining Import Settings for Price Lists

eCatalog price list terms (commercial data) are imported into eCatalog price lists using standard Import Manager
functionality.

After creating a price list object for your eCatalog, the next steps are to create a sample import file, in Excel or CSV
format, then define the import settings for importing actual price data. The columns in the sample file will be used to
map fields in the Import Manager wizard, which will allow the system to later ingest a sheet that contains actual
data.

Sample Excel Price List Load File

The following two screenshots show examples of price list import files, one containing price break and quantity
information, and the other one containing price break, quantity, unit, start date, and end date information.

Price Example

This example sheet is an Excel file that contains 10 columns and 8 products. Each product has three prices with
price breaks that change based on the quantity of the product being sold.

For example, using the first product row shown in the below screenshot (ID = 121171), the price breaks are as
follows:

Break No. Quantity Price

1 1-3 2.79

2 4-9 1.79

3 10-100 0.89

i) | B G D = I S N < . H [ - |

1 _«::ID:> Pricel Plmin Plmax Price 2 P2Zmin P2max Price3d P3min P3max
211121171 2.79 1 31.79 4 9 0.89 10 100
3 (121177 2.95 1 3 2.49 ] 50.99 10, 100
4 121178 2.89 1 31.89 4 9 0.99 10 100
5 121179 3.99 1 3279 4 90.79 10 100
6 121184 1.99 1 30.79 4 9 0.49 10 100
7 1121192 17.76 1 39.70 4 9 5.76 10 100
8 121193 7.29 1 3549 4 9 2.99 10 100
9 121150 9.99 1 3 5.99 4 9 2.99 10 100
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Prices with Units and Dates

To also import Unit, Start Date, and End Date values, which are optional, a corresponding column for each value
must also be present on the sheet. In the below example—which shows columns for 'Price1' only—there is a
'P1Unit,"'P1StartDate,' and 'P1EndDate’ column. Each subsequent price (Price2, Price 3, et al.) will also have its
own unit, start date, and end date columns.

4 A | B C | D | E F | G

1 <ID= Pricel |P1Unit P1lmin Plmax| P15tartDate P1EndDate
2 121171 2.79 is04217.unit.USD 1 3 9/1/2019 10/31/2019
3 121177 2.99 is04217.unit.uUsD 1 3 9/1/2019 10/31/2019
4 121178 2.89 iso4217.unit.USD 1 3 9/1/2019 10/31/2019
5 |121179  3.99 iso4217.unit.UsD 1 3 9/1/2019 10/31/2019
6 121184  1.99 iso4217.unit.USD 1 3 9/1/2019 10/31/2019
7 1121192 17.76 iso4217.unit.UsD 1 3 9/1/2019 10/31/2019
8 121133 7.29 iso4217.unit.USD 1 3 9/1/2019 10/31/2019
9 |121150  5.99 iso4217.unit.UsSD 1 3 9/1/2019 10/31/2019

Creating an Import Configuration for a Price List

The following steps for creating a price list import configuration use a sheet that contains columns for all available
price list (commercial terms) elements: value, unit, quantities, and dates. These steps assume that you have
already created a sample file. Throughout the Import Manager, the elements within the price list (terms) are
referred to as commercial data.

1. Inthe Tree, expand the relevant eCatalog.
2. Select and right-click the price list that you want to import prices to, and then click Edit import configuration.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 11
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¥ Delete

Ctrl+C
Ctrl+ X

. The Import Manager displays on the Select Data Source screen.

[T1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

. On this screen, select File. The data source will always be File for commercial data import configurations.

. While still on the Select Data Source screen, click the ellipsis button (E) next to the Filename field and

choose the sample upload file, then click Next.
. Onthe Select Format screen, the format will be prepopulated with either Excel or CSV, depending on the

format of your sample sheet.

. Make any additional configurations (‘Has Header,' "Trim whitespace,' 'Use date and number formatting from
sheet'), then click Next.
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Import Manager

Steps Select Format
1. Select Configuration Format | Excel iy
2. Select Data Source Converter for files in Microsoft Excel format that contain ane abject per raw,
3. Select Format Has Head
as Header
4, Map Data ¥es ¥
5. Identify Objects Trim whitespace yes -
6. Identify Destination
Use date and number formatting from sheet |15 o
7. Select Business Rules
8. Advanced Settings
Conversion Preview:
<ID= > Pricel > |P1dnit > P 1min > |P1Imax » [P15tartDate * |P1EndDate * |Price2
121171 2,79 jso4217.unit... |1 ] 2019-09-01  [2019-10-31 1.79
121177 2.99 an421?.ur1it. w1 I3 2019-09-01  2019-10-31 (249
121178 2.89 fsn421?.ur1it. w1 I3 2019-09-01  [2019-10-31 1.89
121179 13.99 an421?.ur1it. w1 I3 2019-09-01  2019-10-31 .79
121134 1.99 an421?.ur1it. w1 I3 2019-09-01  2019-10-31 0.79
121192 17.76 an421?.ur1it. w1 I3 2019-09-01  2019-10-31  B9.75
121193 7.29 an421?.ur1it. w1 I3 2019-09-01  [2019-10-31 5.49
121190 9.99 Fsc421?.ur1it. w1 ] 2019-09-01  [2019-10-31 5.99
< 3

Back Mext Finish Cancel

Mapping Commercial Data in the 'Map Data' Step
In the Map Data step, a number of mappings must be specified manually. The 'Auto Map' feature will not work for
commercial data mappings, though it can be used to map the ID or Name columns. ID is required.
To start the mappings, click a source column, then click Map. The Map Column to dialog displays.
2. Select the column to map, then click Map. The Map to dialog displays.

3. Inthis example, the first column has already been mapped to ID; the first price column, 'Price1,' has been
selected; and the Commercial Data radio button has been selected in the Map to dialog.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 13



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

[ Import Manager it
Steps Map Data
1. Select Configuration Source:
2. Select Data Source <ID>» ;IPricel > I>1Unit > [p-1min > P imax > [pistartDa
3. Select Format 121171 1 3 9/1/19
4. Map Data 121177 .99
5. Identify Objects s o
121179 3.99
ify Destinat D
6. Identify Destination S T O
7. Select Business Rules 171192 17.78/
i () Name
8. Advanced Settings s
Result: O Attribute
D=<ID> (®) Commerdal Data
121171
121177 () Product Classification Link Data set |3
121178 () Product Reference Group 1
121179
Value
191134 () Asset Reference O]
121192 () Classification Reference (O Uit
Auto Map Map!
(") Entity Reference () Min. Quantity
| (O reference Meta-Data (O Max. Quarntity
() Parent () start Date
(") Object Type () End Date
() Variable
() Multivalued Variable
() Overrides product
() Add child to override
[ Mandatary
Cancel oK

. The name of the price list will display in the Data Set field.

From the Group list, select the preferred quantity break.
. Choose one of the following options to determine which field of the commercial list that the data from the Excel
sheet should be mapped to:

« Select Value to map the column to the value field.

« Select Unit to map the column to the unit field and have the unit display along with the term value.

« Select Min. Quantity to map the column to minimum quantity in the selected group or price break.

« Select Max. Quantity to map the column to maximum quantity in the selected group or price break.
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« Select Start Date to map the column to the start date when the price becomes valid.
» Select End Date to map the column to the end date of the selected group or price break.

Check the Mandatory box if you want rows without a term value to be skipped on import so none of the

information that may be related to a product without a specified term value will be imported. Click OK.

Follow the previous steps until all columns of the sheet are mapped. For example, in this sheet, after mapping

the 'Price1' column to Commercial Data > Group: 1 > Value, the remaining columns will be mapped as follows:

The 'P1min' column will be mapped to Commercial Data > Group: 1 > Min. Quantity

The 'P1max’ column will be mapped to Commercial Data > Group: 1 > Max Quanity

The 'P1Unit' column will be mapped to Commercial Data > Group: 1 > Unit

The 'P1StartDate’ column will be mapped to Commercial Data > Group: 1 > Start Date
The 'P1EndDate’ column will be mapped to Commercial Data > Group: 1 > End Date
The 'Price2' column will be mapped to Commercial Data > Group: 2 > Value, and so forth.

The remainder of the columns will follow the same pattern. Click Next when finished.

Completing the Import Configuration

1. Onthe Identify Objects screen, if the products in the source file are not identified as existing products in the
system, the 'Match Result' will be 'New.' Click Next.

On the Identify Destination screen, several options are available, which are detailed at length in the Import

Manager - Identify Destination topic in the Import Manager documentation. For the purposes of
commercial data imports:

Reject Updates should be left unchecked, since a setting on the Advanced Settings screen of the wizard
will control how commercial lists are updated.

Import Manager

Steps Identify Destination

1. Select Configuration
2. Select Data Source Approver User 4 (IUSER.4)
3. Select Format :

Import Workspace Main e
4. Map Data
5. Identify Object Default Parent Primary Product Hierarchy (Product hierarchy 1|f...
6. Identify Destination Default Chject Type: | Frimary Froduct Classification
7. Select Business Rules Batch Directory (Mone) Reset
8. Advanced Settings

Test Only Import ]

Feject Mew ]

Reject Updates ]

Back Mext Finish Cancel
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3. Onthe Select Business Rules screen, business rules can be specified to run upon import if required for your
business needs. For more details, see the Import Manager - Select Business Rules topic in the Import
Manager documentation. Click Next.

4. Onthe Advanced Settings screen, any options can be selected based on your business needs, but the only
options relevant to commercial data appear in the Replace/Update Options area.

» Todelete all existing content of the commercial list(s) and replace it with the content of the new file, select
Replace entire existing list(s) with content of import file.

o Tokeep the existing content of the commercial list(s) and only replace the commercial data of the product
IDs included in the new file, select Only update commercial data for objects included in import file.

For more information on all options available on the Advanced Settings screen, see the Import Manager -
Advanced Settings topicin the Data Exchange documentation.

Impert Manager
Steps Advanced Settings
1. Select Configuration Context English US - A
2. Select Data Source
Import Process Template: Impaorter
3. Select Format
4. Man Data Match Units By Name I
5. Identify Objects Approve Import Changes |
6. Identify Destination Auto-Initiate STEP Workflows on Item Creation
7. Select Business Rules A
Trigger STEP Workflow import events on Item Updates
. N ag po pd O
Suppress Re-Translations
Auto select Import Mode (O]
Force Database Import 9]
Force Domain Import 9]
Replace/Update Options Replace/Update Terms

() Replace entire existing list{s) with content of import file

(®) Only update commerdial data for objects induded in import file

Remove Options rRemove Un-Mapped Values v

Back Mext

5. Click Finish to complete the wizard. The Save Import Configuration dialog displays. It is recommended to
save the import configuration and check 'Don't import now' in case changes need to be made to the
configuration before importing live data. Click OK.

See the Running a Data Import topic in the Data Exchange documentation for information on how to save
the import configuration.
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Save Import Configuration

Save Options

Save to Funﬁguraﬁunsﬂmport Configurations/AcmePrices
O Start Import Process: | Importing

() Import now

conce

6. The price listimport configuration is saved in the specified classification structure as an XML file of the object
type Import Manager Configuration (stibo.ImportManagerConfig).

7. A price list can now be imported. See the next section of this topic, Importing Prices, for details.

Editing a Saved eCatalog Import Configuration

To make changes to an existing eCatalog import configuration, do the following.

1. Right-click on the price list and select Edit import configuration.

Tree

: ice List i
[#-{[] GOSN Receiver =
Description

[+-{[] Merge_Golden_Root ?
&-{0] Promotions Mame »
= Publications > ID

@ Templates Ny P

&Il AutoPage Publications _

i+-Ifl Standard Publications > Object Type

@ Flatplanner Publications * Immutable

- (@l Spring Wedding Catalog » Act as selection list

[H-{[T] Primary Product Hierarchy

* Import Configuration

EEI--@ Collections
£}l eCatalogs Import Data
E- Acme Prices Edit import configuration I
- eCat Copy Cirl+C
{4 Recyde Bin 36 Cut Ctrl+X
> Delete

2. The Import Manager wizard displays, starting on the Select Data Source screen.
3. Make the desired edits following the same steps listed above for creating a new configuration.
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4. Alternatively, you can edit the configuration by right-clicking on the saved import configuration object in the
classification hierarchy. See the Maintaining a Saved Import Configuration topic in the Data Exchange
documentation for details.
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eCatalog price lists are imported using standard Import Manager functionality. In STEP Workbench, these imports
can be initiated from STEP Workbench menu (i.e., File > Import > Data) or from the price list object itself. This
topic explains how to import commercial data information for eCatalog price lists through a right-click action on the

price list object.

To import eCatalog price information:

1. Right-click on the price list object and select Import Data.

Tr

(]
(]

[#-[ 7] Web Sites US

+-{[] Customer Root

&£ Entity Root

-] GDSN

-] GDSN Receiver

{E| Merge_Golden_Root
#-f] Promotions

@ Fublications

i Primary Product Hierarchy
@ Collections

E|- eCatalogs

{E| Company Hierarchy Data Root

o9

@ Desaripon

Mame

* D

> Mame
* Ohject Type
» Immutable

* |\Act as selection list

E}- Acme Prices “"
- ~-4Z| Acme Spring Prices
: -8 eCat
":ﬁ' Recyde Bin %
*

Import Data

Edit import configuration

Copy Ctrl+C
Cut Ctrl+X
Delete

2. Inthe Import Commercial Data dialog, click the ellipsis button (E) next to Filename, then navigate to and

select the file you want to import.
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Import Commercial Data

Filename |C:‘|.IJsers‘l.user‘|,Dumments1l,!Cummercial Data\ChmmData3Breaks. xlsx " |

{®) Start background process |Imporﬁng Three Breaks |

() Import on-ine

Replace JUpdate Terms
() Replace entire existing list{s) with content of import file

{®) Only update commerdal data for objects induded in import file

[ o | [ Conce

3. Inthe Replace/Update Terms area, select one of the following options:

« Todelete all existing content of the commercial list(s) and replace it with the content of the new file, select
Replace entire existing list(s) with content of import file.

o To keep the existing content of the commercial list(s) and only replace the commercial data of the product
IDs included in the new file, select Only update commercial data for objects included in import file.

The choice you made when defining the import configuration on the Advanced Settings screen of the Import
Manager wizard will be set as default, but you can override this option by selecting the other option.

4. SelectImport on-line option if you want the process to run and show the result online instead of going to a
background process. Once the process completes, the Import Report window will show the complete report.

5. Click OK.

To view the imported data, use one of the methods outlined in the Viewing Price Lists topic.
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Viewing and Searching Price Lists

After importing a price list, the commercial data terms can be viewed both from the price list and from the
product that is included in the list. Additionally, the data can be searched when viewing it from the product.

View Terms from a Price List

1. Navigate to and select the relevant price list in your eCatalog.
2. Onthe Price List tab, expand the Content of area.
3. The contents of the price list are displayed.

Tree

r_=| Aszets s
r_=| Bulk Update Configurations
r_=| Classifications

r_=| Configurations

--@ Index Words Product

Acme Spring Prices - Price List

<

[ Price List IRy
& Description

3 Content of Price

F_=| Merchandising Hierarchy Showing 24 terms. There are terms for & different products,
[+~ Suppliers
g UNF;FI;ISC—CDDE Product ¥ Walue * |Unit * Min Quantity
r_=| Web Sites US * Pink & Green Party Hat 2,73 ﬁﬁso‘}zl?.unit.USD} L
&1-{0] Company Hierarchy Data Ro > Pink & Green Party Hat 179 |$ﬁsu421?.unit.L.lSD} e
E5-{] Customer Root > Pink & Green Party Hat  0.89 |5ﬁsu421?.unit.usn} o
[+ Entity Root
{EI GOSN * Cosmic Party Hat .99 |$ﬁ50421?.ur1it.U5D} . ||L
1-[C] GDSN Receiver > Cosmic Party Hat 2.49 |$ﬁso421?.unit.USD} a
i-{0) Merge_Golden_Root > Cosmic Party Hat 0.99 |$ﬁsu421?.unit.L.lSD} o
F#-{] Promotions : .
@ Publications * Purple & White Party Hat 2,89 |5ﬁ5n421?.unlt.USD} .1
F- [ Primary Product Hierarchy » Purple & White Party Hat (.89 § (s04217.0mit.USD)  |...|4
-5 Collections > Purple & White Party Hat ~ 0.99 |$ﬁso421?.unit.USD} |10
gl eCatal
= -E;r E-E‘A °95P . I > Wellow & Pink Party Hat ~ 3.99 |$ﬁsu421?.unit.L.lSD} N
- Cme Frices

~§5 Acme Spring Prices * [fellow & Pink Party Hat 2.79 |5ﬁ5n421?.unit.USD} o |
. G- eCat > Wellow &Pink Party Hat 0,79 |$ﬁsu421?.ur1it.L.I5D} o
=17 Recyde Bin vll<

Search Terms from a Price list

1. Navigate to and select the relevant price list in your eCatalog.

2. Select the relevant commercial list, then click the Price List tab.
3. Expand the Content of area to view the content of the list.
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4. Inthe Product field, enter a product name or ID, or use an asterisk to enter part of a name or ID, and then click
Search.

-

| Product |P‘ir1k* | Search

Shaowing 24 terms. There are terms for & different products.

Product * |Value ¥ [Unit * |Min Quantity * [Max Quantity * |Start Date

* Pink & Green Party Hat 2.79 § (iso4217.unit. USD) |Z| 3 2019-09-01 00:00:00
» Pink & Green Party Hat 1.74 |$ (is04217.unit. USD) |Z| 9 2019-09-01 00:00:00
* Pink & Green Party Hat 0.89 |$ {iso4217.unit. USD) |Z| 100 2019-09-01 00:00:00
» Cosmic Party Hat 2.99 |$ (is04217.unit. USD) |Z| 2019-09-01 00:00:00
» Cosmic Party Hat 2,49 |$ {is04217.unit.USD) |Z| 2019-09-01 00:00:00
» Cosmic Party Hat 0.99 |$ (1504217 .unit.USD) |Z| 100 2019-09-01 00:00:00
* Purple & White Party Hat 2,89 |$ (iso4217.unit. USD) IZI 2019-09-01 00:00:00
* Purple & White Party Hat 1.89 |$ (iso4217.unit. USD) IZI 2019-09-01 00:00:00
> Purple & White Party Hat ~ 0.99 |$ {is04217.unit.USD) |...] 100 2019-09-01 00:00:00
> [fellow & Pink Party Hat 3.99 |$ (is04217 . unit.USD) |Z| 2015-09-01 00:00:00
> Nellow & Pink Party Hat 2,79 |$ {is04217 . unit. USD) |Z| 2019-09-01 00:00:00
» Nellow & Pink Party Hat 0.79 |$ (is04217.unit. USD) 100 2019-09-01 00:00:00
» Christmas Party Hat 1,99 |$ {iso4217.unit. USD) 3 2019-09-01 00:00:00

5. The search results are displayed.

| price List |[JERY
Coesaptn
@ Content of Price
Product |F‘ir1k"1 | | Search |
Search result showing & terms. There are terms for 2 different products,
Product * |Value ¥ |Unit ¥ |Min Quantity ¥ |Max Quanti
* Pink & Green Party Hat 2,79 |$ (is04217.unit,LISD) |Z| 1 3
* Pink & Green Party Hat 1.79 |$ (iso4217.unit.USD) |Z| ]
* Pink & Green Party Hat 0.89 |5 (is04217.unit,USD) |Z| 10 100
* Pink & Green Pom-Pom Hat  [7.29 |5 (is04217.unit,USD) |Z| 1 3
* Pink & Green Pom-Pom Hat  |5.49 |$ (is04217.unit,LISD) |Z| ]
* Pink & Green Pom-Pom Hat [2.99 |$ (iso4217.unit.USD) |Z| 10 100
| * | Add Product

6. Toshow the entire content of the list again, leave the search field blank, then click Search.
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View Terms from a Product

1. Inthe Tree, navigate to and select the relevant product.
2. Onthe Commercial tab, expand the Terms area.

3. Allprice lists that the product appears in are displayed. Any STEP Publisher commercial data lists that the
product is linked to will also display. For more information on commercial data, see the Commercial Data

section of the STEP Publisher (InDesign) documentation.

Pink & Green Party Hat rev.0.7 - Commercial

TSI | Tables || Category Profile || Proof View || Classification Rules || Status || State Log || Tasks

i Product Data Containers Sub Products References Referenced By Image
[+-{T) Hardware
..1—_=| Displays @ Terms I
--{'_'=| Furniture Terms List ID Terms List Name  * [Terms List Type > |Dwner * [Owner Versions * [Value »
-3 Automotive > SpringPrices Spring Prices Price 'i Spring Wedding Catalog  English US 2.79
[ Building Products — - - - - - :
"1__=I Electrical and Electronics » SpringPrices Spring Prices Price ﬁ Spring Wedding Catalog English US 1.79
..r_'=| Food and Beverage » SpringPrices Spring Prices Price ﬁ Spring Wedding Catalog  English US 0.89
B3 Kitchen *| eCatPrices eCat Prices Price h eCat 3.15
E‘E Fl%t: SL::T_:E:S »{eCatPrices eCat Prices Price eCat 12,99
= arty Ha
E|r_=| Paper Hats » FrenchPrices French Prices Price Acme Party Supplies French FR. 3,99
- Balloon Hats * BummerPrices Summer Prices Price E Summer Wedding Catalog 2,79
@--‘C.;ildren's Hats * SummerPrices Summer Prices Price E Summer Wedding Catalog 1.79
P e Pink & Green Party Hat
a Purple & White Party He * SummerPrices Summer Prices Price Summer Wedding Catalog 0.89
-
- Pet Hats » cmeSpringPrices | Acme Spring Prices  Price Acme Prices 2. 79
G"lj Masks »1 hcmeSpringPrices  Acme Spring Prices  Price h Acme Prices 1.79
7[5 Str
g % Ch'Tda;EI;'?d Parti # AcmeSpringPrices  Acme Spring Prices  Price h Acme Prices 0.89
- ild Birthday Parties -
-5 Wedding > |Add Term

Itis also possible to edit terms lists from both locations. See the next topic in this section, Editing Price Lists, for
more information.
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Editing Price Lists

After being imported, eCatalog price list terms can be edited, either from a price list or from a product.

Edit Price List Terms from a Price List

There are two ways to edit price list terms from a price list. The Value and Unit can be edited directly from the list.
The Value, Min Quantity, Max Quantity, Start Date, and End Date values can be edited by right-clicking on a
productin the list and accessing the Edit Terms dialog.

Editing Terms Directly

1. Navigate to and select the relevant price list, then click on the Price List tab.
2. Expand the Content of section to view the content of the list.

3. Double-click in any Value field to edit the value.

4. Click the ellipsis button (E) in the Unit field to edit the unit.

Editing Terms from the Edit Terms Dialog

1. Navigate to and select the relevant price list, then click on the Price List tab.
2. Expand the Content of section to view the content of the list.

3. Right-click the right arrow next to the preferred term, then choose Edit Term.
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- Description
@ Content of Price
Product
Showing 24 terms. There are terms for & different products.
Product » [Value * [Unit
* Pink & Green Party Hat 2.79 |$ (is04217.un
> Pink & Green Party Hat 1.79 |$ (iso4217.un
> a9 § (s04217.n
W Hide |$ (is04217.un
> Show All Columns |$ﬁsu421?.un
E Rotate Table |$ (iso4217.un
k Add Product Ctrl+Plus |$ (is04217.un
7 Remove Product  Ctrl+Minus |$ (s04217.un
k |$ {iso4217.un
e B = |$ (iso4217.un

4. Inthe Edit Terms dialog, double-click inside the field for the term that you want to edit, then click OK when
complete.

Edit Terms for product "Pink & Green Party Hat" and terms list "Spring Prices”,

Value ¥ [Min Quantity ¥ |Max Quantity » |Start Date ¥ |End Date
s .79 1 3 2019-09-01 00:00:00 2019-10-31 00:00:00
* 11,79 v = 2019-09-01 00:00:00 12019-10-31 00:00:00
* 10,89 10 100 2019-09-01 00:00:00 12019-10-31 00:00:00
* |Add Term
Ok Cancel

Add Terms to a Price List
1. Follow the steps outlined above to access the Edit Terms dialog.
2. Click Add Term to add a new row to the Edit Terms dialog.
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Edit Terms for product "Cosmic Party Hat" and terms list "Spring Prices",

Value » [Min Quantity » |Max Quantity » |Start Date » |End Date
* (2,49 v = 2019-09-01 00:00:00 2019-10-31 00:00:00
> 10,99 110 1100 2019-09-01 00:00:00 12019-10-31 00:00:00
4 L
* | Add Term
OK Cancel

3. Enter the relevant term values in the new row, then click OK.

Remove Terms from a Price List
1. Follow the steps outlined above to access the Edit Terms dialog.

2. Inthe Edit Terms dialog, right-click the arrow next to the term you want to remove, then choose Remove
Term.

Edit Terms for product "Cosmic Party Hat" and terms list "Spring Prices",

Value » Min Quantity » IMax Quantity » |Start Date » |End Date
> 12,49 4 g 2019-09-0100:00:00  [2019-10-3100:00:00 #
> 0,99 10 100 2019-09-01 00:00:00  2019-10-31 00:00:00
E Hide v
Show All Rows
Rotate Table ok Cancel
Add Term Ctrl+Plus
L I Remowve Term  Ctrl+Minus I

Add Products to a Price List

Instead of importing products into a price list, you can add products manually, for which you then can edit the
terms.

1. Navigate to and select the relevant price list, then click on the Price List tab.
2. Expand the Content of section to view the content of the list.
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Right-click the menu icon (arrow) next to one of the terms in the table, and then click Add Product.
Alternatively, scroll to the bottom of the table-based view, then click Add Product.

 Price List |[JERY
®-Desaripton
@ Content of Price
Product |
Showing 24 terms. There are terms for & different products.
Product * Value * |Unit
* Pink & Green Party Hat 2,79 I$ (is04217.un
* Pink & Green Party Hat 1.79 |$ (is04217.un
> nas |$ (is04217.un
E Hide |¢ (is04217.un
» Show All Columns |$ (is04217.un
5 YRotate Table ¢ (1s04217.un
7 |Add Product Ctrl+Plus | § (s04217.un
_} Remowve Product  Ctrl+Minus I‘ (s04217.un
E Edit Term § (1s04217.un
P e ey s I$ﬁsn421?.un

Inthe Add Product to Terms List dialog, click the ellipsis button (E) .

Add Product to Terms List

Steps Select Product
1. Select Product Select Product To Add To The Terms List
2. Enter Terms | " .

Back Next Finish

Browse to or search for the relevant product on the Select Product dialog, then click Select. Only one product
can be selected; an option to multi-select products is not available.

. After selecting the product, click Next on the Add Product to Terms list dialog.

Inthe Add Product to Terms List dialog, click Add Term to add a new blank row to the dialog.
Enter the relevant terms, then click Add Term again to add more terms.
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9. Click Finish. The product is now available in the list.

Remove Products from a Price List

1. Follow the same initial steps as above for adding a product, but click Remove Product instead of Add
Product.

2. The Remove Terms for dialog displays, showing all the terms that will be affected.
3. Click Delete to remove the product from the list.

Remowe Terms for product "Purple & White Party Hat" and terms list "Acme Spring Prices".

Value ¥ [Min Quantity * Max Quantity ¥ |Start Date » |End Date >
» (2,89 1 7 12019-09-01 00:00:00 2019-10-31 00:00:00
> .39 4 a 2019-09-01 00:00:00 2019-10-31 00:00:00
* 10,99 10 100 12019-09-01 00:00:00 2019-10-31 00:00:00

Delete Cancel

4. Click the ellipsis button (|...), then either browse or search for a Product, and then click Next.

5. Click Add Term and fill in the relevant fields.
6. Click Finish.

Edit Price List Terms from a Product

Price lists can also be edited from product objects that appear in at least one price list. When viewing terms lists for
a product on the Commercial tab, the Value and Unit can be edited directly. The Value, Min Quantity, Max
Quantity, Start Date, and End Date values can be edited by right-clicking on a terms list and accessing the Edit
Terms dialog.

Editing Price Commercial Data Directly

1. Inthe Tree, navigate to and select the relevant product.

2. Onthe Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.
3. Double-click in any Value field to edit the value.

4. Click the ellipsis button (|...)) in the Unit field to edit the unit.

Editing Commercial Data from the Edit Terms Dialog

1. Inthe Tree, navigate to and select the relevant product.

2. Onthe Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.
3. Right-click the right arrow next to the relevant term, then choose Edit Term.
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5| Add Term Ctrl+Plus Price
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4. Inthe Edit Terms dialog, double-click inside the field for the term that you want to edit, then click OK when

complete.

Add Terms to a Product

Terms can be added to a product from the Edit Terms dialog, or from the Add Term to Product dialog. Follow
these steps to add a term from the 'Add Term to Product' dialog.

1. Inthe Tree, navigate to and select the relevant product.

w N

Add Term.

»

Add Term to Product

Inthe Add Term to Product dialog, click the ellipsis button (...)).

On the Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.
Click the Add Term link at the bottom of the list. Or, right-click on the right arrow next to any term and select

Steps Select Terms List
1. Select Terms List Select Terms List To Add To Th
2, Enter Terms

e Product

Back

Mext Finish

Cancel

5. Inthe Select Terms List dialog, browse to or search for the relevant commercial list, then click Select to close

the dialog.
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lect Terms List

| Search

[#-{[7] Company Hierarchy Data Root
@ Customer Root
[+l Entity Root
&-{0) GDSN
-] GDSM Receiver
{E Merge_Golden_Root
-] Promotions
Eli eCatalogs
: --- Acme Prices
=B eCat
----- eCatalog Configuration

{5 atrrics|

@ Publications

@ Details

Select Cancel

6. Click Next to go to the Enter Terms screen, then click Add Term to add a new row under Enter Terms.

Add Term to Product

Steps Enter Terms
1. Select Terms List Value » |Min Quantity > [Max
= u * 2.7 1 3
* 11.79 4 ]
* 0.89 10 100

| O ——

ﬂﬁdﬂ Term

Back Mext Finish Cancel

7. Enter the relevant terms, then click Finish.
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Remove a Single Term from a Product
1. Follow the steps outlined above to access the Edit Terms dialog.
2. Right-click the right arrow next to the preferred term, then choose Remove Term.

Remove All Terms from a Product

Removing all terms from a product will remove the product itself from the terms list.

In the Tree, navigate to and select the relevant product.
On the Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.

Right-click the right arrow next to the relevant term, then click Remove Term.
The Remove terms for product dialog displays.

Verify that you want to remove the listed terms, then click Delete. All the product terms are removed, and the
product itself is also removed from the list.

o~ w N =
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Copying Price Lists

You can make a copy of a price list and use it as a price list in a different publication. You can also copy price lists to
STEP Publisher publications to use as commercial data lists. For more information on Commercial Data, see the
Commercial Data section of the STEP Publisher (InDesign) documentation.

1. Navigate to the price list that you want to copy, then right-click and choose Copy.

Tree —
. {7 Customer Root

[#-F= Entity Root

- GDSN

-] GDSN Receiver

{E| Merge_Golden_Root
I Promotions

@ Publications

r_=| Primary Product Hierarchy
@ Collections

=-J eCatalogs Import Data

. E}- "!"C"”E Prices Edit import configuration

- - ECat Sﬂk

I 'ﬁ' Recyde Bin

@'E:tnhllnfhm

Copy Ctrl+C
Cut Ctrl+X

%@

¥ Delete

2. Navigate to and select the eCatalog that you want to copy the list to, then right-click and choose Paste.

@ Customer Root
-2 Entity Root
(] GDSN
&[] GDSM Re
{E Merge_G
@ Promatio

<
=
@ Description

Mew eCatalog
Mew Price List

Create Collection From File...

-1 Publicatic : :
1j Primary Mew eCatalog Configuration
B Collectio Mew List z
= __E;ai:f Copy Ctri+C
5. 3 ocut Cirl+X
[ Paste Ctrl+V
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3. Ifthe eCatalog already has a list, a warning dialog will display to let you know that the existing price list will be
deleted when you paste the new one. Click OK to continue and overwrite the price list, or click Cancel to exit.

The eCatalog Already Has a Price List

The eCatalog already has a price list. Do you want to delete the existing price list?

Cancel

4. Ifthe eCatalog does not already have a list, the Duplicate dialog displays.

5. Enter an ID and Name for the new list, then check the Duplicate terms box if you want to copy the actual
contents of the list.

Duplicate

ID SummerPrices
Mame |Summer Prices

Duplicate terms

Cancel

6. Click OK. The copied terms list is now present in the eCatalog.

[+-{[] Customer Root
-2 Entity Root

#1-{[] GDSN

-] GDSN Receiver
{E| Merge_Golden_Root
-] Promotions

@ Publications

r_=| Primary Product Hierarchy
@ Collections

E|- eCatalogs

: [+ Acme Prices
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Selecting Products for eCatalogs

There are two methods of selecting the products that should be part of an eCatalog. One way is to use the
contents of the price list itself, which is achieved by selecting the Act as selection list on the price list. See the
Creating a Price List topic for more information.

The second method is to link a collection to your eCatalog. In the workbench, collections can be created in two
ways:

1. Using the Search tab, perform a search, and create a collection of the results. This creates a dynamic product
selection for the catalog that can later be refreshed.

2. Using an import file, create a collection of the contents. This creates a static product selection for the catalog.
If you later want to alter the product selection, you will have to delete this file-created collection and create a
new one.

For information on how to create a collection using either method, see the Creating Collections topicin the
Getting Started / Super User Guide documentation.

This topic explains how to add collections to eCatalogs.

Add a Dynamic Collection to an eCatalog Through Search

To add a dynamic collection to an eCatalog created from a search:
1. Onthe Search tab, search to locate the products that you want to be part of the eCatalog.

2. When the search is complete, click the 'Save as Collection' button .
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ﬁ |Search: *hat =]

| 1 [Object Type =

= ’VProduct ‘ﬂ

=

M

H =
Displaying 29 of 29 results Show Details

ame
GRAY HAT [ = 208511 ~

w Gray Top Hat D = 137535

L m Industrial Hard Hat /D = 151195

I Pink & Blue Giraffe Party Hat [0 = 121155
m Pink & Blue Owl Party Hat ID = 121215

L m Pink & Green Party Hat D = 121171

L m Pink & Green Pom-Pom Hat 1D = 121795
™ Purple & White Party Hat 1D = 138942

™ Purple & White Party Hat ID = 121175

m Red Hat D = 109305

| Red Top Hat ID = 132457

> Slﬂl'lilt I = 17985~
* i Yellow & Pink Party Hat 1D = 12717% W

< >

- Jperations on Entire Result
B |& &

o
Ll
—

Ready ‘\

Worlkflow " Bookmarks ” Syskem Setup ” BG Processes (4) ]

Inthe Save as Collection in Background Process dialog, browse or search for the eCatalog that you want
to add the collection to.

Save as Collection in Background Process

Search

@ Collections
=] eCatalogs
-l eCat
- Details
Collection ID 259778

Collection Mame Hat Collection

K Cancel
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4. Forthe Collection Name parameter, add a Name for the new collection (IDs are autogenerated).

5. Abackground process launches. When complete, the collection is added to the eCatalog.

+-{] GDSN
-f] GDSN Receiver
{E| Merge_Golden_Root
[#-{[7] Promotions
@ Publications
r_=| Primary Product Hierarchy
@ Collections
Eli eCatalogs
: E}- Acme Prices

Acme Spring Prices
: -5 ecat
ﬁ Recyde Bin

Add a Static Collection to an eCatalog Through a File

To add a static collection to an eCatalog created from a file:

1.

2.

Right-click on your eCatalog and select Create Collection from File.

{El Company Hierarchy Data Root
@ Customer Root

= Entity Root

-] GDSN

-] GDSN ket B New eCatalog

{E| Merge_5

Mew Price List

Create Collection From File...

{E| PrumuﬁnjE
- Publicati

r_=| Primary f
@ Collectior

-l eCatalog
i - Acml
{ . ﬁ c

Jﬁ Recyde

Inthe Create Collection From File dialog, locate the file to be imported.
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Copy
Cut

Paste

Export eCatalog

Ctrl+C
Ctrl+X
Ctrl+V
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[1 Create Collection From File X
Look in: | Imports V| & = M-
:'S"% Product IDs
Recent [tems
Desktop
Documents
This PC
@ File name: |Product IDs. txt |
Netwark Files of type: |AJI Files — |
Collection ID | 112705 |
Collection Mame |Mew Products
Products
Classifications
Assets

3. Forthe Collection Name parameter, add a Name for the new collection (IDs are autogenerated).
4. Forthe File Contains parameter, select if the import file contains IDs of products, classifications, or assets.
5. Click OK to start a background process which will create the new collection.
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Another required step in creating an eCatalog is to add an eCatalog Configuration. This is an export
configuration that specifies the data to be included in the eCatalog, as well as the data format of the eCatalog.

To create and configure an eCatalog Configuration:

1. Navigate to the relevant eCatalog, then right-click and select New eCatalog Configuration.

[+-{[] Customer Root

{E| Company Hierarchy Data Root ~ eCatalog

<catdog

[+ =3 Entity Root
[+-{] GDSN
(+-{] GDSM Receiver

Mew eCatalog
Mew Price List

Create Collection From File...

[+-{[] Merge_Golden_|

Mew eCatalog Configuration

i) Promotions
@ Publications

r_=| Primary Produ
-5 Collections

Eli eCatalogs %

[+ eCat
&% Recyde Bin

Mew List ¥
Copy Ctrl+C
Cut Ctrl+X
Paste Ctrl+V

Export eCatalog

The Configure eCatalog wizard displays on the Select Format screen. The Configure eCatalog wizard is

based on the Export Manager with added functionality, allowing you to map the prices from the price list
information of the current eCatalog into the selected output format. You can choose among the following
eCatalog formats, which are supported via export options:

o Excel: See the Excel Format section of the Data Exchange documentation for more information.

 BMEcat 1.2: An XML-based standard for electronic data transfer by electronic catalogs. See the BMEcat

Format section of the Data Exchange documentation for more information.

« Ariba CIF 3.0: A simple comma-delimited list of catalog items and their attributes. See the Ariba CIF 3.0

Format section of the Data Exchange documentation for more information.

o cXML.: Exports data using Ariba cXML 1.2 and is an XML-based language designed specifically for
communication of e-commerce business documents. See the cXML Format section of the Data Exchange
documentation for more information.

« XCBL: exports data using the CommerceOne XML-based language. See the xCBL Format section of the
Data Exchange documentation for more information.
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Configure an eCatalog Configuration for Excel

1. Select Excel from the dropdown list on the Select Format screen of the Configure eCatalog wizard, then click

Next.

2. Onthe Map Data screen, click on the relevant information that you want included in the export (for instance,
<ID>), then click the arrow button in the right part of the window to add it to the list of data to be exported. Ata
minimum, you must map ID and a price column. Name is also recommended.

3. Tomap the price data, expand Commercial (eCatalog). Select the relevant price list (in this example, 'Price'),
then click the arrow icon to add it as a column in the Excel sheet.

Configure eCataleg Acme Prices

Steps

Map Data

1. 5elect Configuration

2, Select Objects

3. Select Format

4. Map Data

5. Advanced

&. Select Delivery Method

----- <Mame >

----- <Parent ID=

----- <0Object Type Mame =

----- «<Product-Override Child ID >
----- <Is deleted =

----- "Constant Yalue™
----- «<Page Number =
-Gelect Attribute
[+#-Classifications
[#-Index Waords
[+-Product Classification Linkg
[-Product References
[+--Asset References
[+-Classification Refereges
[+-Entity References
+-5TEF Workflow Tagk Info

--Cu X
--Eystem Setup

Exports data in Excel format.

I} 2 Column (2 mapped)
® <ID> 1D 7| .

@ <Name = | e N

Inherit Data and References

Back Mext Finish Cancel

4. Inthe Enter Quantity Break dialog that displays, enter the quantity break value (e.g., 1), then click Save.
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Enter Quantity Break

Enter quantity break value
1

Save Cancel

5. The price value is mapped, followed by the break number in brackets, e.g., [1].

% Column (3 mapped)
@ <ID>1ID >
= <MName = | W
- Price [1] el (B

6. If youwould like to apply transformations to the values that display in the export, click the 'flipper' icon next to
Price to view the fields that have the transformation icon (|€# ) available. When mapping a commercial value,

you have the same transformations available as you would have for a product attribute, but the available
aspects differ.

For more information on applying aspect transformations to outbound data, see the Aspect - Transform
Outbound topicin the Data Exchange documentation. For a broader overview on applying transformations
to outbound data, see the Outbound Map Data - Transform topic in the Data Exchange documentation.

|} 2 Column (3 mapped)
@ D> 1D x| .
€~ <Name > batlladlhe
® Price [1] badl| Eadlhd
|} Header | "Price in SpringPrices”™ %' b
[} Value|Price [1] % x

7. Click the transformation icon (|4 ) next to the Header field to change the header that will display in the Excel

export spreadsheet for the price value. In the Transformations dialog, enter the desired header in the Source
field, then click Save.
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Transformations

Target: Header

Source: |Price in SpringPrices - Break 1 |

|Saue||Eancei|

8. Click the transformation icon () next to the Value field if you want to apply a transformation to the values that

display in the price columns. If changing the aspect, the following selections are available:

Price - default; the value field from the commercial list

Currency - the unit from the commercial list

Price and currency - both the value and the unit from the commercial list
Currency ID - the ID of the unit from the commercial list

Min Quantity - the Min. Quantity value from the commercial list

Max Quantity - the Max. Quantity value from the commercial list

Start Date - the Start Date value from the commercial list

End Date - the End Date value from the commercial list

Transformations

Target: Value

Source: Price [1]

Aspect: | price “
sl

Currency

Price and currency

Currency ID

Min Quantity

Max Quantity

Start Date

End Date W

Add Transformation

|Saue||R.eset||Ea’1cel|

9. Repeat the process to map values from additional price breaks. The following screenshot shows a sample
mapping with ID, Name, and three price breaks with transformations applied:
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|> 2 Column (5 mapped)
- <D= ID

b
€

@ <MName:>

@ PriceAndCurrency [1]

[* Header "Price in SpringPrices - Break 17 &

|} Value PriceAndCurrency [1] %‘

@ PriceandCurrency [2]

|} Header | "Price in SpringPrices - Break 27 %'

|} Value |PriceAndCurrency [2] '@:-'

@ PriceAndCurrency [3]

[+ Header "Price in SpringPrices - Break 3" &

81 e 8
b
€

|} Value PriceAndCurrency [3] %

10. Click Next on the Map Data screen when finished.

11. Onthe Advanced screen, additional options specific to eCatalog exports are included in addition to the options
available in the standard Export Manager. For information on the standard options available on this screen, see
the Export Manager - Advanced section of the Data Exchange documentation. The additional options for
eCatalogs are highlighted in the below screenshot.
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Configure eCatalog Acme Prices

Steps Advanced

1, 5elect Configuration

[] Tag conversion Coupaon
2. Select Objects

[] Locale conversion from context

3. Select Format

4, Map Data Resolve Inline References

5. Advanced () Export Only Lacal Inline References
6. Select Delivery Method (®) Export Inherited Inline References

Indude Calculated Attribute Values

Warkspace |Main e
Context |English LIS e
Use effective date

(®) Current date of when export is initiated

(O) Effective Date: |2018-07-26 | ...

[ ] selfcontained references

Back Finish Cancel

« Use effective date: Select this option if you want the system to take the 'start date' and 'end date' specified
on the price list into consideration when exporting prices. 'Use effective date' ensures that prices will only be
included in the export if the effective date lies within the specified period. Leave this box unselected to have
the system disregard the 'start date' and 'end date' applied to products on the price list.

If selected, then specify one of the following options:

« Select Current date of when export is initiated to ensure that the prices included in the export have
a start date that occurs on or before the date that the export is initiated. If the start date of a price on the
price occurs after the current date, then that price will not be included, since it is not yet valid.

» Select Effective to ensure that the prices included in the export have a start date that occurs on or
before the date specified. As with the 'current date' option, if the start date of a price on the price list
occurs after the effective date, it will not be included in the export.

If no date span has been specified for the prices, the effective date will have no effect.

« Selfcontained references: Select this option if there is a need for the export to be self-contained. This
ensures that no references will be allowed to point to anything outside of the export.

12. Click Next to advance to the Select Delivery Method screen.
13. Select File, then click Finish.
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Configure an eCatalog Configuration for BMEcat

This section describes how to configure information specific to eCatalogs when using the BMEcat format for your
eCatalog Configuration. For full details on how to configure the rest of the information required for a BMEcat
export, see the BMEcat Format section of the Data Exchange documentation.

1.
2.
3.

Select BMEcat from the dropdown list on the Select Format screen of the Configure eCatalog wizard.
Fill out any relevant fields on the screen, then click Next.

On the Map Data screen, the following mandatory fields are marked in red text with an asterisk: Supplier
Article ID, Short Description, Order Unit, and Price. Since this guide concerns eCatalogs, the Price field will be
mapped.

To map the price data, expand Commercial (eCatalog). Select the relevant price list (in this example, 'Price'),
then click the arrow icon next to Price to add it as a column in the Excel sheet.

Configure eCatalog Acme Prices

Steps Map Data
L Select Configuration, | <ID= Converts data to a BMEcat 1.2 format (see www.bmecat.org).
2, Select Objects, | | i <Nama=
3 SelectFormat | | L. <Parent D> [» |"? Artide Features (0 mapped) ~
Data = | i <Object Type Mame =
4-Map Ject Tpe T-:ume ] [ |Order Unit * |Nothing mapped & %
A | <Product-Override Child ID=
6. select Delivery Method | <Is deleted:> [+ \Content Unit| Nothing mapped & |
----- "Constant Value™
----- <Page Number > I} Packing quantity|Mothing mapped % by
--Gelect Attribute
Bl-Classifications |} Price Quantity | Mothing mapped %- >
[+-Index Words
Mini tity | Mothi d
- Product Classification Links [> Minimum Quantity Nothing mappe X
(+-Product References I} Quantity Interval Mothing mapped % by
[+-Asset References
[+-Classification References |} Price start date Mothing mapped %‘ *
[+-Entity References
#-STEP Workflow Task Info [} PPrice end date Nothing mapped & |
- Multi level References
o o i
- Multi level Parent attributes |> Daily Price? Nothing mapped % X
..... Insert Referenced Objects |} |.|? Price = (0 mapped)
[=-Coy izl (eCatalog)
I@ _..--ﬂ"" [} |¢J MIME Info (0 mapped)
[+]-Custom Attributes [» |"? MIME Info (Catalog Group Assets) (0 mapped)

--System Setup
i-Attributes Inherited from Classification

[» |"? IUser Defined Extension (0 mapped)

[» |"? Artide Reference (0 mapped)

[» |"? Catalog Group Map (0 mapped)

Inherit Data and References * =Mandatory field  Red = Unmapped mandatory field

Back Mext Finish Cancel

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 44



5.

6.

7.

T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

In the Enter Quantity Break dialog that displays, enter the quantity break value (e.g., 1), then click Save.

Enter quantity break value
1

Save Cancel

The price value is mapped, followed by the break number in brackets, e.g., [1].

[»||¥ Price = (1 mapped)
&= Price [1] by

If you would like to apply transformations to the values that display in the export, click the 'flipper' icon next to
Price to view the fields that have the transformation icon (|€# ) available. When mapping a commercial value,

you have the same transformations available as you would have for a product attribute, but the available
aspects differ. The available aspects in the price transformations for the BMEcat format are the same as those
available for Excel exports. See the above subsection, 'Configure an eCatalog Configuration for Excel,' for
more information.

For more information on applying aspect transformations to outbound data, see the Aspect - Transform
Outbound topic in the Data Exchange documentation. For a broader overview on applying transformations
to outbound data, see the Outbound Map Data - Transform topic in the Data Exchange documentation.

2 Price * (1 mapped)
@ Price [1]

[» Type Price [1]

|} Amount * |Price [1]

|} Currency | Mothing mapped

|} Tax |Price [1]

[» Factor | Price [1]

|} Lower Bound|Price [1]

USSR >

B0 (|| 48 | |[ B (| o || || S

|} Territory | Price [1]
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8. Click Next on the Map Data screen when finished.

9. Onthe Advanced screen, additional options specific to eCatalog exports are included in addition to the options
available in the standard Export Manager. For information on the standard options available on this screen, see
the Export Manager - Advanced section of the Data Exchange documentation. The additional options for
eCatalogs are the same as those available for Excel exports (User effective date, etc.). See the above
subsection, 'Configure an eCatalog Configuration for Excel,' for more information.

10. Click Next to advance to the Select Delivery Method screen.
11. SelectFile, then click Finish.

Configuring eCatalog Configurations for Other Formats

The process for creating an eCatalog Configuration for other available formats (Ariba CIF 3.0, cXML, and xCBL)
is very similar to that for creating configurations for Excel and BMEcat exports. Though the available data fields
differ on the Map Data screen of the Configure eCatalog wizard for each format, the process for mapping
Commercial (eCatalog) > Price is the same, and the available aspects for transformations are the same.
Additionally, the same options (‘Use effective date,' etc.) are available on the Advanced screen.

Editing an Existing eCatalog Configuration

1. To edit an existing eCatalog Configuration, right-click the configuration and select Edit.

EI- eCatalogs

=I5 Acme Prices

=~ [eait |
. [#-[J Hat Collection
[+ eCat IE Copy Ctrl+C
-1 Recyde Bin % cut Cirlex
¥ Delete

2. The Configure eCatalog wizard displays. Follow the same steps as you would when creating a new
configuration.
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Exporting an eCatalog

1.

In the Tree, right-click the relevant eCatalog, then select Export eCatalog. The Export eCatalog wizard
displays on the Refresh Collection screen.

Select Refresh before each run if you want the collection to be refreshed before each export. This option is
only relevant for collections created from a search. It does not apply if your collection was created from a list or
if you are using the price list as the product selection.

Export eCatalog - Acme Prices

Steps Refresh Collection
1. Select eCatalog Refresh before each ruri
2. Refresh Collection
3. Schedule Process

4. Mame Process

Back Mext Finish Cancel

On the Schedule Process screen, specify whether you want to export the eCatalog immediately or ata
specified time in the future, then click Next. You have the following options:

« Now: Starts the eCatalog Export process and delivers the eCatalog as specified in the eCatalog
Configuration.

« Later: Schedules a single delivery in the future at the specified time and date.

o Weekly: Schedules a recurring eCatalog export for one or more of the days of the week. This option
requires a time, a start date, and optionally an end date. If no end date is specified, the eCatalog scheduling
process runs until it is ended manually.

« Monthly: Schedules arecurring export of the eCatalog for a specific day of every month.

« Later and repeat: Schedules delivery in the future at the specified time and date and at an interval given in
minutes.

Important: Consider the time zone of the application server compared to that of the workbench (the client)
where the schedule is created or viewed. When scheduling a job, the local time zone is displayed in the
workbench, but the time zone of the server is used to run the background process. Although displayed, the
time zone of the client is not included in the instruction to the server to run the job. This can cause confusion
about when the job will run since the scheduled time is not automatically converted to accommodate
potential differences in time zones.
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Export eCatalog - Acme Prices

Steps Schedule Process
1, select eCatalog Start
2. Refresh Collection
(@) Mow
3. Schedule Process
4, Name Process (O Later
() Weekly
() Monthly

() Later and repeat

Start now

Back Finish Cancel

4. Onthe Name Process, provide a name for the process. An auto-generated name is provided, but you can
change it to make it easier to identify the process.

Export eCatalog - Acme Prices

Steps Name Process

1, select eCatalog
2. Refresh Collection
3. schedule Process

= Process Mame: | Export eCatalog "Acme Prices'

Back Mext Cancel

5. Click Finish to either start the export process or a scheduling process, depending on the specified settings.
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